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iSeries Navigator for Wireless

iSeries™ Navigator for Wireless is an i5/0S® program that runs on a Web application server. With iSeries
Navigator for Wireless, administrators can remotely monitor and manage system performance, status,
jobs, and messages using an Internet-ready telephone, a personal digital assistant (PDA) with a wireless
modem, or a traditional Web browser on a workstation.

Managing multiple systems is one of the more
challenging aspects of running a growing business. IBM
introduced Management Central to help administrators
manage their systems. Users have enjoyed the ease,
flexibility, and power of Management Central. From
managing fixes and running commands across multiple
systems to viewing real-time graphs of their systems
performance, administrators have used Management
Central to do their jobs much more efficiently.

With iSeries Navigator for Wireless, administrators have more flexibility in how they access and interact
with Management Central.

After you have configured iSeries Navigator for Wireless to run on a Web server on your central system,
enter the system URL into your Internet-ready telephone, PDA, or browser to perform the following
tasks:

* Watch system status.
* View properties of the system.
* View detailed summaries:

— Commands

- Packages and products

- Inventory

— Fixes

— Collection services

- Users and groups

— System values

+ Manage Integrated xSeries® Servers: Run commands on all Integrated xSeries Servers at the same time
or on just one server, and start or shut down the servers.

* Run i5/0S commands across multiple systems.
* View and interact with monitors:

— System monitors: View the metrics and current values being monitored, as well as the top 20 items
(jobs, disk units, and so forth) that make up the metric value. Work with jobs listed in the monitor
(display details, hold, release, end).

— Job and message monitors: View all jobs and messages across systems matching monitor criteria.
See metrics and current values being monitored. Work with the jobs and messages listed in the
monitor (display details, hold, release, end, delete, reply).

— File monitors: View detailed status of files, including system path, size, date modified, and the text
that triggered the file.
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— B2B activity monitors: View business-to-business transaction details, and see metrics and current
values being monitored.

* Limit what users can do by enabling read-only support, or by setting user-access levels with
Application Administration. Allow users to view status information without the ability to take action.

This information is intended to help you start using iSeries Navigator for Wireless by providing tips on
which devices to use, how to install and configure the required elements, and by giving you an overview
of the functions.

What’s new for V5R4
This topic highlights changes to iSeries Navigator for Wireless in V5R4.

New in V5R4, you can configure your iSeries Navigator for Wireless to share multiple monitors across
multiple users. This new feature allows you to see shared monitors along with ones that you have
created. For more on these new easy setup instructions, see [“Configuring a Web application server” on|

| What’s new as of April 2007
| iSeries Navigator for Wireless does not support WebSphere® Application Server Version 5.0, 6.1, or later.

| In the user options file, the SHARE_MON property specifies whether shared monitors display on your
| wireless device. See [“Customizing your connection” on page 17| for more information.

How to see what’s new or changed

To help you see where technical changes have been made, this information uses:
* The ¥ image to mark where new or changed information begins.
* The 4% image to mark where new or changed information ends.

To find other information about what’s new or changed this release, see the

Printable PDF

Use this to view and print a PDF of this information.

To view or download the PDF version of this document, select [iSeries Navigator for Wireless| (about 637
KB).

Saving PDF files

To save a PDF on your workstation for viewing or printing:

1. Right-click the PDF in your browser (right-click the link above).
| 2. Click the option that saves the PDF locally.

3. Navigate to the directory in which you want to save the PDF.

4. Click Save.

Downloading Adobe Reader

| You need Adobe Reader installed on your system to view or print these PDFs. You can download a free

| copy from the IAdobe Web site| (www.adobe.com/products/acrobat/ readstep.htrnl)-.lﬁr .

2 System i: Connecting to System i iSeries Navigator for Wireless


http://www.adobe.com/products/acrobat/readstep.html

Setting up iSeries Navigator for Wireless

To use iSeries Navigator for Wireless, you must meet certain software and hardware requirements. You
must decide which kind of wireless device to use and what kind of applications you need to install and
configure.

Related concepts

["Managing your systems with iSeries Navigator for Wireless” on page 19|

You can manage your systems from a wireless device. Use iSeries Navigator for Wireless to interact
with monitors in Management Central and in Integrated xSeries Servers. You can run commands,
work with tasks and systems, and control user access.

Hardware and software requirements

Before setting up iSeries Navigator for Wireless, you should determine whether you have all the
necessary software and hardware to run iSeries Navigator for Wireless.

The following elements are required to run the latest enhancements of iSeries Navigator for Wireless:

* Licensed Product 5722-XP1: The iSeries Access for Wireless product that includes iSeries Navigator for
Wireless.

* A device to run the function:
— An Internet-enabled telephone with a wireless Internet service

— A personal digital assistant (PDA) with a Web browser, a wireless modem, and a wireless Internet
service

— A traditional Web browser on a workstation

* A system running OS/ 400® V5R2, or later, in a TCP/IP network. This will be your central system used
by Management Central.

* A Web application server running on your central system, such as these:
— Apache Software Foundation (ASF) Jakarta Tomcat application server
— WebSphere Application Server

Note: iSeries Navigator for Wireless does not support WebSphere Application Server Version 5.0,
6.1, or later.

— Any other application server that runs on the central system and that can host servlets

The following figure shows that a wireless device sends and receives information through the Internet
and through a firewall when it is connected to a Management Central central system. iSeries Navigator
for Wireless and your Web application server are both installed on the central system. The central system
points to four endpoint systems.

iSeries Navigator for Wireless 3
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Figure 1. Wireless device connecting to Management Central

Selecting a device

You must choose devices that are compatible with iSeries Navigator for Wireless.

Internet-ready telephones and wireless personal digital assistants (PDAs) are a rapidly changing
technology. They differ in screen size and many other significant characteristics. This information helps
you choose devices that are compatible with iSeries Navigator for Wireless. Other wireless devices might
also be compatible if they support wireless Internet browsing, but the interaction might be different.

Selecting a device: Internet-ready telephones

When you select an Internet-ready telephone to use with iSeries Navigator for Wireless, you should
consider the telephone’s physical characteristics, its compatibility with iSeries Navigator for Wireless, the
Web browser supported, and the wireless Internet services available.

Consider the following elements when you select an Internet-ready telephone to use with iSeries
Navigator for Wireless:

¢ The physical characteristics of the telephone itself (display size, button location, and so forth)
* The Web browser (often called a microbrowser or a minibrowser) supported on the telephone

* The wireless Internet services available with the Internet-ready telephone in the geographical areas
where you want to use it

The display size of the Internet-ready telephone often affects how easy it is to use. In general, the more
horizontal lines the telephone displays, the easier it is to view data. Regardless of the display size, you

will often need to scroll down in the telephone display using buttons or other scrolling mechanism. The
width of the displayed lines should also be a consideration.
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An Internet-ready telephone is typically already loaded with a microbrowser. When you select a
particular telephone, you are also making your browser choice. iSeries Navigator for Wireless currently
supports the Openwave Mobile Browser, Version 3.1, and later (formerly called UP.Browser). For best
results, choose a telephone that supports this microbrowser.

The wireless Internet service is what transports the data to and from your Internet-ready telephone. It is
not the same as the voice service for your telephone, although the two might be packaged together by a
particular provider. Make sure that the telephone you select is supported by a wireless Internet service
available in the geographical areas where you want to use it.

Compatibility with iSeries Navigator for Wireless

The following Internet-ready telephones are compatible with iSeries Navigator for Wireless.

Telephone Type of testing Wireless service Comments
Mitsubishi T250 Device AT&T PocketNet Small font preference is
recommended.

Note: Other phones have been tested with a simulator, including the Ericsson R280 LX.

Other Internet-ready telephones might also be compatible. The Openwave Mobile Browser is licensed by
a number of telephone manufacturers around the world. Any HTML browsers, WML phones, and

Blackberries with the OS version 4.0, which contains an HTML browser, will work with iSeries Access for
Wireless. In addition, many of the manufacturers offer support on more than one model of telephone. The
list of telephones supported by the OpenWave Mobile Browser can be found at the Openwave: Supported

Phones Web page.
Related information

[ [Openwave: Supported Phones Web page]

[ [Openwave Web site]

Selecting a device: PDAs
iSeries Navigator for Wireless uses a Web browser running on your personal digital assistant (PDA).
Unlike Internet-ready telephones, the selection of a browser is not tied to your choice of PDA device.

If a Web browser was packaged with your PDA when you bought it, you can install additional Web
browsers. You can download many Web browsers for PDA devices over the Internet.

PDA browser compatibility with iSeries Navigator for Wireless

Many different Web browsers exist for PDA devices. Often, the browsers differ in the HTML elements
they support. Some browsers handle text differently from others. Some display images and tables, while
others do not. Some browsers offer higher levels of protection or security than others. The following
browsers support the necessary elements to run iSeries Navigator for Wireless from a PDA:

* AvantGo Version 3 or later

* EudoraWeb Version 1.1 or later

* Go.Web Version 6.0 - for RIM Blackberry

Other Web browsers that run on PDAs might also be compatible. Be aware that the differences in how
browsers display HTML can cause iSeries Navigator for Wireless to appear and behave differently from

the browsers listed previously.

If you need extra security, use a browser that supports Secure Sockets Layer (SSL).

iSeries Navigator for Wireless
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PDA compatibility with iSeries Navigator for Wireless

The following PDAs are compatible with iSeries Navigator for Wireless:

PDA Operating system Wireless modem Wireless service
Palm V or Vx Palm OS Version 3.3 Minstrel V AT&T

Palm III or IIIx Palm OS Version 3.3 Minstrel IIT AT&T

RIM Blackberry RIM Built in GoAmerica
Kyocera QCP 6035 Palm OS Built in Sprint

Many other PDAs are most likely compatible. Because iSeries Navigator for Wireless runs in a browser,
the choice of PDA should not make a difference. However, only the PDAs listed previously were tested.
Any device that lets you perform Web browsing and that supports HTML might be compatible with
iSeries Navigator for Wireless.

Modem and wireless Internet service for the PDA

You need to choose a modem that is compatible with your PDA selection. In addition, you need to find a
wireless Internet Service Provider (ISP). The wireless Internet service transports the data to and from
your PDA using the modem. When choosing a modem and service, make sure that you select a
combination that is supported in the geographical areas where you want to use your PDA.

Related information

 [AvantGd

[ [Eudora Web site]

[ [GoAmerica Communications Web site|

Selecting a device: PCs
You can also use a traditional Web browser with iSeries Navigator for Wireless.

IBM? iSeries Navigator for Wireless is designed to run on an Internet-ready telephone or PDA. However,
because it runs on a browser in a PDA, iSeries Navigator for Wireless can also run on a traditional Web
browser. Any current workstation Web browser should work because PDA browsers have more
limitations.

Because iSeries Navigator for Wireless only needs a small display, one suggestion is for you to put a
small window of your browser in the corner of your workstation. Then you can keep current on your
systems and monitors without having to clutter your desktop.

If you are using a traditional Internet browser on your PC, you can select Get Report from the main
menu to display all information in a full browser.

Developing an Internet protection program

Because user authentication of iSeries Navigator for Wireless takes place over the Internet, you should
develop an Internet protection program to protect authentication information.

Because the iSeries Navigator for Wireless servlet needs to obtain the user ID of the remote user, the Web
application server needs to be configured or set up to authenticate the user. The servlet uses this user ID

to communicate with Management Central. Because this authentication can take place over the Internet, a
protection plan is necessary to protect the authentication information (user ID and password).
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Also, the data that is transferred between the client and the server contains systems management
information. An analysis should be done to determine the level of protection you require for this data.
The following questions need to be considered in developing this plan.

* What services will be used to access the servlet (use the Internet, use browsers on clients attached to
the central system, or both)?

* What client devices will be used and what are the security capabilities of the browsers used on the
devices?

* How will the desired protection be configured or be set up on a Web application server, such as IBM

WebSphere Application Server, Apache Software Foundation (ASF) Tomcat servlet engine, and IBM
HTTP Server for i5/0S?

* What is the sensitivity of the data transferred between the client and server?

When developing a protection plan, refer to AS/400° Internet Security Scenarios: A Practical Approach. The
IBM WebSphere Application Server Web page and ASF Jakarta Tomcat home page might also be helpful
in developing a protection plan. These pages also provide documentation on the security protection
capabilities of the client devices and browsers to be used.

Related information

[ [AS/400 Internet Security Scenarios: A Practical Approach|

[ [[BM WebSphere Application Server

[ [ASF Jakarta Tomcatf

Configuring your wireless environment

Before using iSeries Navigator for Wireless, ensure that you have properly configured your Web
application server and firewall.

Related concepts

[“Connecting to your central system” on page 15|
To begin using iSeries Navigator for Wireless, you must first establish your connection to the central
system. Enter the URL of your central system into your wireless device.

“Configuring your ASF Jakarta Tomcat servlet engine for HTTP Server (powered by Apache)” on page]
g
These tasks help you set up an Apache Software Foundation (ASF) Tomcat servlet engine for HTTP
Server to run iSeries Navigator for Wireless.

[“Configuring your WebSphere Application Server, Base Edition, Version 5.1” on page 9|
These tasks help you set up iSeries Navigator for Wireless to run using WebSphere Application Server
v5.1, Base Edition.

[‘Configuring your WebSphere Application Server, Express Edition, Version 5.1” on page 10|
These tasks help you set up iSeries Navigator for Wireless to run using WebSphere Application Server
v5.1, Express Edition.

[“Configuring your WebSphere Application Server, Version 6.0” on page 11|
These tasks help you set up iSeries Navigator for Wireless to run using WebSphere Application Server
v6.0.

Configuring a Web application server

You can choose one among several Web application servers to run the iSeries Navigator for Wireless
servlet; for example, an Apache Software Foundation (ASF) Jakarta Tomcat servlet engine or a WebSphere
Application Server.

The configuration steps for a Web application server vary depending on what kind of Web application
server you use.
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Note: iSeries Navigator for Wireless does not support WebSphere Application Server Version 5.0, 6.1, or

later.
Related tasks
[“Configuring Management Central” on page 13|
You can take full advantage of the capability that iSeries Navigator for Wireless provides when you

interact with Management Central. iSeries Navigator for Wireless does not need a PC to run, but you
need a PC to set up Management Central.

Configuring your ASF Jakarta Tomcat servlet engine for HTTP Server (powered by Apache):

These tasks help you set up an Apache Software Foundation (ASF) Tomcat servlet engine for HTTP
Server to run iSeries Navigator for Wireless.

Prerequisites

Before you begin, you must have QSECOFR authority and IBM HTTP Server (5722-DG1) installed.

Note: The following steps create an instance of an HTTP server. Therefore, you cannot use these

instructions to set up iSeries Navigator for Wireless on an existing HTTP server.

To set up your Tomcat servlet engine, follow these steps:

1.

Run the following command to add the iSeries Navigator for Wireless servlet to the ASF Jakarta
Tomcat servlet engine. It also sets up an IBM HTTP Server named <HTTPInstanceName> that listens
for requests on port <port number>.

CALL QSYSDIR/QYPVSETUP '-tomcat [-httpinstance <HTTPInstanceName>] [-port <port
number>] [-javaversion <java version>]"'

The parameters in this command are defined as follows:

-tomcat
This parameter specifies that ASF Tomcat is the servlet engine used to run iSeries Navigator
for Wireless.

-httpinstance <HTTPInstanceName>
This parameter specifies the name of the HTTP instance used to run the ASF Tomcat servlet
engine. The name cannot include spaces and must be less than 10 characters long. If you do
not specify an instance name, the default is MCP.

-port <port number>
This parameter specifies the port for the HTTP Server to listen for requests. If the port is not
specified, the default is 8110.

-javaversion <java version>
This parameter specifies the version of Java" Developer’s Kit to use. Valid values for this
parameter are 1.3 and 1.2. If you do not specify a Java version, the default is 1.3 if it is
installed; otherwise 1.2 is used.

ASF Tomcat runs in process. This means that it starts and ends when the HTTP server starts and
ends.

Run the following command to start your HTTP server.
STRTCPSVR SERVER(*HTTP) HTTPSVR(<HTTPInstanceName>)

Now that you have finished setting up your Web application server, you can continue to configure your
wireless environment.
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[‘Configuring your wireless environment” on page 7|
Before using iSeries Navigator for Wireless, ensure that you have properly configured your Web
application server and firewall.
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Related information

[ [Apache Tomcat home page]

Configuring your WebSphere Application Server, Base Edition, Version 5.1:

These tasks help you set up iSeries Navigator for Wireless to run using WebSphere Application Server
v5.1, Base Edition.

Prerequisites

Before you begin, you must have QSECOFR authority and must have the following products installed:
e IBM HTTP Server (5722-DG1)
* WebSphere Application Server Version 5.1, or later

Notes:

1. The following steps create an instance of an HTTP server. Therefore, you cannot use these
instructions to set up iSeries Navigator for Wireless on an existing HTTP server.

2. The following steps assume that you are already running WebSphere Application Server. For
setup information and to determine prerequisites, go to the [WebSphere Application Server
home page and select the appropriate version.

To set up your WebSphere Application Server, follow these steps:

1.

Make sure that the QEJBAS51 subsystem is running. If it is not, run the following command:
STRSBS QEJBAS51/QEJBAS51

Run the following command to set up iSeries Navigator for Wireless to run using WebSphere
Application Server v5.1, Base Edition as the servlet engine. It creates an instance of WebSphere
Application Server named <WASInstanceName> and an IBM HTTP Server named
<HTTPInstanceName> that listens for requests on port <port number>.

CALL QSYSDIR/QYPVSETUP '-wasversion 5733W51 [-nodename <node name>] [-wasinstance
<WASInstanceName>] [-httpinstance <HTTPInstanceName>] [-port <port number>]'

The parameters in this command are defined as follows:

-wasversion 5733W51
This parameter specifies that Websphere Application Server v5.1, Base Edition is used to run
iSeries Navigator for Wireless.

-nodename <system name>
This parameter specifies the short name of the system that iSeries Navigator for Wireless is
being set up for. For example, if the system name is yoursystem.yourcompany.com, the
<system name> is yoursystem.

-wasinstance <WASlInstanceName>
This parameter specifies the name of the WebSphere instance that is created to run iSeries
Navigator for Wireless. The instance that is specified cannot exist yet; otherwise, you will
receive an error when the command is run. If you do not specify an instance name, the name
of the instance is MCP.

-httpinstance <HTTPInstanceName>
This parameter specifies the name of the HTTP instance used to run the WebSphere servlet
engine. The name cannot include spaces and must be less than 10 characters long. If you do
not specify an instance name, the default is MCP.

-port <port number>
This parameter specifies the first number of a block of six ports. The HTTP Server listens for
requests on <port number>, and the application server listens on <port number> + 1 through
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<port number> + 5. If you do not specify a port number, the default is 8110 for the HTTP
Server and 8111 - 8115 for the application server.

3. Run the following command from the QSHELL command line to start your WebSphere Application
Server.

/QIBM/ProdData/WebAS51/Base/bin/startServer iSeriesNavigatorForWireless -instance <WASInstanceName>

The port number for the administration console of this instance of the WebSphere Application Server
is displayed after the application server has started.

4. Run the following command to start your HTTP server.
STRTCPSVR SERVER(*HTTP) HTTPSVR(<HTTPInstanceName>)

Now that you have finished setting up your Web application server, you can continue to configure your
wireless environment.

Related concepts

[‘Configuring your wireless environment” on page 7|
Before using iSeries Navigator for Wireless, ensure that you have properly configured your Web
application server and firewall.

Configuring your WebSphere Application Server, Express Edition, Version 5.1:

These tasks help you set up iSeries Navigator for Wireless to run using WebSphere Application Server
v5.1, Express Edition.

Prerequisites

Before you begin, you must have QSECOFR authority and must have the following products installed:
» IBM HTTP Server (5722-DG1)
* WebSphere Application Server Version 5.1, or later

Notes:

1. The following steps create an instance of an HTTP Server. Therefore, you cannot use these
instructions to set up iSeries Navigator for Wireless on an existing HTTP server.

2. The following steps assume that you are already running WebSphere Application Server. For
setup information and to determine prerequisites, go to the [WebSphere Application Server|
home page and select the appropriate version.

To set up your WebSphere Application Server, follow these steps:

1. Make sure that the QASE51 subsystem is running. If it is not, run the following command:
STRSBS QASE51/QASE51

2. Run the following command to set up iSeries Navigator for Wireless to run using WebSphere
Application Server v5.1, Express Edition as the servlet engine. It creates an instance of WebSphere

Application Server named <WASInstanceName> and an IBM HTTP Server (powered by Apache)
named <HTTPInstanceName> that listens for requests on port <port number>.

CALL QSYSDIR/QYPVSETUP '-wasversion 5722E51 [-wasinstance <WASInstanceName>]
[-httpinstance <HTTPInstanceName>] [-port <port number>]"'

The parameters in this command are defined as follows:

-wasversion 5722E51
This parameter specifies that WebSphere Application Server v5.1, Express Edition is used to
run iSeries Navigator for Wireless.

-wasinstance <WASInstanceName>
This parameter specifies the name of the WebSphere instance that is created to run iSeries
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Navigator for Wireless. The instance that is specified cannot exist yet; otherwise, you will
receive an error when the command is run. If you do not specify an instance name, the name
of the instance is iSeriesNavigatorForWireless.

-httpinstance <HTTPInstanceName>
This parameter specifies the name of the HTTP instance used to run the WebSphere servlet
engine. The name cannot include spaces and must be less than 10 characters long. If you do
not specify an instance name, the default is MCP.

-port <port number>
This parameter specifies the first number of a block of six ports. The HTTP Server listens for
requests on <port number>, and the application server listens on <port number> + 1 through
<port number> + 5. If you do not specify a port number, the default is 8110 for the HTTP
Server and 8111 - 8115 for the application server.
3. Run the following command from the QSHELL command line to start your application server.
/QIBM/ProdData/WebASE51/ASE/bin/startServer <WASInstanceName> -instance <WASInstanceName>
The port number for the administration console of this instance of the WebSphere Application Server
is displayed after the application server has started.
4. Run the following command to start your HTTP server.
STRTCPSVR SERVER(*HTTP) HTTPSVR(<HTTPInstanceName>)

Now that you have finished setting up your Web application server, you can continue to configure your
wireless environment.

Related concepts

[‘Configuring your wireless environment” on page 7|
Before using iSeries Navigator for Wireless, ensure that you have properly configured your Web
application server and firewall.

Configuring your WebSphere Application Server, Version 6.0:

These tasks help you set up iSeries Navigator for Wireless to run using WebSphere Application Server
v6.0.

Prerequisites

Before you begin, you must have QSECOFR authority and must have the following products installed:
* IBM HTTP Server (5722-DG1)
* WebSphere Application Server Version 6.0, or later

Notes:

1. The following steps create an instance of an HTTP server. Therefore, you cannot use these
instructions to set up iSeries Navigator for Wireless on an existing HTTP server.

2. The following steps assume that you are already running WebSphere Application Server. For
setup information and to determine prerequisites, go to the [WebSphere Application Server|
home page and select the appropriate version.

To set up your WebSphere Application Server, follow these steps:
1. Make sure that the QWAS6 subsystem is running. If it is not, run the following command:
STRSBS QWAS6/QWAS6

2. Run the following command to set up iSeries Navigator for Wireless to run using WebSphere
Application Server v6.0 as the servlet engine. It creates an instance of WebSphere Application Server
named <WASInstanceName> and an IBM HTTP Server named <HTTPInstanceName> that listens for
requests on port <port number>.
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CALL QSYSDIR/QYPVSETUP '-wasversion 5733W60 [-nodename <node name>] [-wasinstance
<WASInstanceName>] [-httpinstance <HTTPInstanceName>] [-port <port number>]"

The parameters in this command are defined as follows:

-wasversion 5733W60
This parameter specifies that WebSphere Application Server v6.0, is used to run iSeries
Navigator for Wireless.

-nodename <system name>
This parameter specifies the short name of the system that iSeries Navigator for Wireless is
being set up for. For example, if the system name is yoursystem.yourcompany.com, the
<system name> is yoursystem.

-wasinstance <WASInstanceName>
This parameter specifies the name of the WebSphere instance that is created to run iSeries
Navigator for Wireless. The instance that is specified cannot exist yet; otherwise, you will
receive an error when the command is run. If you do not specify an instance name, the name
of the instance is MCP.

-httpinstance <HTTPInstanceName>
This parameter specifies the name of the HTTP instance used to run the WebSphere servlet
engine. The name cannot include spaces and must be less than 10 characters long. If you do
not specify an instance name, the default is MCP.

-port <port number>
This parameter specifies the first number of a block of six ports. The HTTP Server listens for
requests on <port number>, and the application server listens on <port number> + 1 through
<port number> + 5. If you do not specify a port number, the default is 8110 for the HTTP
Server and 8111 - 8115 for the application server.

Run the following command from the QSHELL command line to start your WebSphere Application
Server.

/QIBM/ProdData/Websphere/AppServer/V6/Base/bin/startServer
iSeriesNavigatorForWireless -profileName instance_name <WASInstanceName>

The port number for the administration console of this instance of the WebSphere Application Server
is displayed after the application server has started.

Run the following command to start your HTTP server.
STRTCPSVR SERVER(*HTTP) HTTPSVR(<HTTPInstanceName>)

Now that you have finished setting up your Web application server, you can continue to configure your
wireless environment.

Related concepts

[‘Configuring your wireless environment” on page 7|
Before using iSeries Navigator for Wireless, ensure that you have properly configured your Web
application server and firewall.

Configuring your firewall
When you use iSeries Navigator for Wireless, you access your system from the Internet. If you have a
firewall, you might have to modify your firewall setup to run iSeries Navigator for Wireless.

If you have never accessed your systems from the Internet and do not have a firewall set up, refer to the
IBM Redbook AS/400 Internet Security Scenarios: A Practical Approach for strategies to set up a firewall. See
the chapters about screened host architecture and screened subnet architecture.

Related information

[ [AS/400 Internet Security Scenarios: A Practical Approach]|
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Configuring Management Central

You can take full advantage of the capability that iSeries Navigator for Wireless provides when you
interact with Management Central. iSeries Navigator for Wireless does not need a PC to run, but you
need a PC to set up Management Central.

Before you begin configuring Management Central, you must complete the following tasks:

1.

Install iSeries Navigator on the PC as a component of iSeries Access for Windows®.

No additional installation is needed. When installing iSeries Access for Windows, select iSeries
Navigator from the list of available components, and then select the components you want (Monitors,
Commands).

Set up Management Central (central system, endpoint systems, monitors, commands).

To connect to Management Central from a wireless device, your Web application server must be set
up on the endpoint system you have configured as your Management Central central system.

Because iSeries Navigator for Wireless is a companion to Management Central, iSeries Navigator for
Wireless uses endpoint systems and monitors that are defined in Management Central to report status
and to monitor metric information.

To configure Management Central for use by iSeries Navigator for Wireless, follow these steps:

1.

Add systems to your network so that you can monitor status. To add endpoint systems, follow the
steps in [Adding endpoint systems to your Management Central networkl

Only systems defined as endpoint systems in Management Central show up in iSeries Navigator for
Wireless. This includes systems with Integrated xSeries Servers. If you want to manage your
integrated servers on a particular system, make sure that the system has been added as an endpoint
system.

When all of your endpoint systems have been added, collect inventory so information about each
endpoint system is available for you to view from iSeries Navigator.

Create monitors with meaningful names, and keep the names short to prevent them from scrolling on
the wireless devices. To create monitors, follow the steps in [Creating a new monitor|

When you give a monitor a meaningful name, you can easily recognize the monitor on a wireless
device, and you will know what it is monitoring for, if it has been triggered, and the severity of a
problem you are looking at.

Monitors in Management Central enable you to set up thresholds, and to perform automation if those
thresholds occur. The goal of iSeries Navigator for Wireless is to keep you informed of the status of
these monitors wherever you are. With iSeries Navigator for Wireless, you can also view metrics and
values on a specific system.

Start and stop monitors.

You have the ability to start and stop monitors from iSeries Navigator for Wireless, but if you start
them in Management Central, your monitors are active and looking for problems, and data will have
already been collected when you access your monitors from a wireless device. Many times after a
problem occurs, you will need to monitor something in more detail. If you predefine these
troubleshooting monitors in Management Central, you can start them later using iSeries Navigator for
Wireless.

Create command definitions.

You can run commands from iSeries Navigator for Wireless. However, entering a long command into
an Internet-ready telephone can be quite cumbersome. That is why your command definitions are also
displayed so you can run the commands in the definitions directly from iSeries Navigator for
Wireless. Create as many command definitions as you would like, but keep the names short so you
can see them on a small display.

To create command definitions, follow these steps:
a. Expand Management Central » Definitions.
b. Right-click Command and select New Definition. The New Command Definition window opens.
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Related concepts

[Management Centrall

[“Configuring a Web application server” on page 7|

You can choose one among several Web application servers to run the iSeries Navigator for Wireless
servlet; for example, an Apache Software Foundation (ASF) Jakarta Tomcat servlet engine or a
WebSphere Application Server.

Related tasks
[nstalling iSeries Navigator]

[Working with monitors|

[Creating command definitions]

Selecting a language
The iSeries Navigator for Wireless default language is English, but you can configure your device to
display your language of choice.

After you install the optional language support fix (PTF), the language can be set on the device being
used, can be set for the browser used on your PC, or can be specified on the URL. If you specify the
language on the URL, follow this URL pattern:

host . domain : port/servlet/McYpvPervasive?Ing= lang
host: The host name of the central system
domain: The domain on which the central system is located
port: The port that the instance of the Web server is listening to
lang: The language to be viewed

Available languages

Language Language identifier Character set
Belgium Dutch nl_BE is0-8859-1
Chinese Simplified zh gb2312
Chinese Traditional zh_TW bigh
Croatian hr is0-8859-2
Czech cs is0-8859-2
Dutch nl is0-8859-1
English en is0-8859-1
French fr is0-8859-1
French Belgium fr_BE is0-8859-1
French Canadian fr CA 1s0-8859-1
French Swiss fr CH is0-8859-1
German de is0-8859-1
German Swiss de_CH is0-8859-1
Greek el is0-8859-7
Hungarian hu i50-8859-2
Italian it is0-8859-1
Italian Swiss it CH is0-8859-1
Japanese ja shift-jis
Korean ko euc-kr
Polish pl is0-8859-2
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Language Language identifier Character set
Portuguese pt is0-8859-1
Portuguese Brazilian pt_BR is0-8859-1
Romanian ro is0-8859-2
Russian ru windows-1251
Slovakian sk is0-8859-2
Slovenian sl is0-8859-2
Spanish es is0-8859-1

Setting the default language and character set for Netscape

To set the language, select Edit » Preferences, and then click Languages (click Add to see a list of

language possibilities). Only the first one in the list is used.

To set the character set, select View » Character Set.

Setting the default language and character set for Internet Explorer

To set the language, select Tools » Internet Options, and then click Languages button (click Add to see a

list of language possibilities). Only the first one in the list is used.

To set the character set, select View » Encoding. (You might need to select More to see the entire list.)

Connecting to your central system

To begin using iSeries Navigator for Wireless, you must first establish your connection to the central
system. Enter the URL of your central system into your wireless device.

When pointing your device to the URL on your central system, use the following format. Carefully
specify the end of the URL (/servlet/McYpvPervasive) exactly as shown:

host.domain:port /servlet/McYpvPervasive

host: The host name of the central system.

domain: The domain where the central system is located.
port: The port that the instance of the Web server is listening to.
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Internet-ready telephone layout

If you have successfully connected to your central system,
the first thing you see when using iSeries Navigator for
Wireless on an Internet-ready telephone is the summary.
It shows you how current the information is, how many
systems are in your list, how many monitors you have
running, and how many tasks you have run in the last 24
hours. It also tells you if any item needs attention by
showing an overall status of OK or Attention at the top
iSeries Navigotor of your display.
0515701 0O2:00 AM If OK is shown, all of your systems, monitors, and tasks

are running smoothly.

If Attention is shown, a system, monitor, or task needs

Dattentionl more attention. If a system is unavailable or if a monitor
or task has failed, an exclamation point is shown next to
1 } Svstens (31 the item that needs attention. If a monitor has been
= Monitors (4) triggered, a bell is shown next to Monitors.

Note: For telephones that do not support graphics, an
asterisk is shown instead of a bell.

3 Taszk= LE

Mennu

PDA browser layout

The personal digital assistant (PDA) browser layout is similar to the Internet-ready telephone. When you
first use iSeries Navigator for Wireless, a summary is displayed, as well as the number of systems that
are unavailable, the number of monitors that failed or were triggered, and the number of tasks that have
failed. Because some compatible browsers do not support graphics, an asterisk (*) is used instead of a bell
when the device displays a triggered status.

Traditional browser layout

The traditional browser layout is exactly the same as the PDA browser layout. However, because of the
increased display size, it looks more basic. To make better use of desktop space, you can put a small
browser window in the corner of your PC to take advantage of Management Central functions while
working with other applications. If you are using a traditional Internet browser on your PC, you can
select Show all from the main menu to display all information on a full browser window.

After you have successfully connected to your system, you might want to customize your connection and
begin managing iSeries Navigator for Wireless.

Related concepts

[‘Configuring your wireless environment” on page 7|
Before using iSeries Navigator for Wireless, ensure that you have properly configured your Web
application server and firewall.

[‘Customizing your connection” on page 17]

You can use several methods to customize connections to iSeries Navigator for Wireless. You can
control whether users can run commands and use monitors, and can specify how long tasks display
information.
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[“Managing your systems with iSeries Navigator for Wireless” on page 19

You can manage your systems from a wireless device. Use iSeries Navigator for Wireless to interact
with monitors in Management Central and in Integrated xSeries Servers. You can run commands,
work with tasks and systems, and control user access.

Customizing your connection

You can use several methods to customize connections to iSeries Navigator for Wireless. You can control
whether users can run commands and use monitors, and can specify how long tasks display information.

Limit user access to Management Central by manually removing functions from iSeries Navigator for
Wireless and by configuring Application Administration, and customize how long summary information
stays on your display before it is cleared.

Limiting user access

You can limit a user’s ability to work with Management Central from a wireless device. Follow these
steps to enable users to view monitors and system status but not take any action from iSeries Navigator
for Wireless.

The following functions can be removed:

* Running commands on the System i platform and Integrated xSeries Servers
e Starting or shutting down Integrated xSeries Servers

¢ Performing any action on a job (hold, release, end)

* Performing any action on a message (reply, delete)

* Starting, stopping, or restarting any monitor

To limit access, you must create the following options file:
1. In the integrated file system, create a file in the following directory:

Directory: QIBM/UserData/05400/MGTC/Pervasive/
File: QYPV_OPTIONS.OPT

2. Enter one of the following text strings into your file:

* readonly=yes
If you specify readonly=yes in QYPV_OPTIONS.OPT, users cannot perform any actions.

* readonly=no
If you specify readonly=no in QYPV_OPTIONS.OPT, all users can perform the following actions:
— Running commands on the System i platform and Integrated xSeries Servers
— Starting or shutting down Integrated xSeries Servers
— Performing any action on a job (hold, release, end)
— Performing any action on a message (reply, delete)

— Starting, stopping, or restarting any monitor
You can also create a user options file named QYPV xxxxxx.OPT, where xxxxxx is the user ID. This user
file overrides QYPV_OPTIONS.OPT, which allows you to grant all users readonly=yes authority by
default while granting specific users all access.
Setting task details retrieval length
Detailed information about tasks is available in the summary window. These details are set to expire in

24 hours. Tasks can still run, but no new data about a task is retrieved from the central system and
displayed on your wireless device before that time.
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To change the expiration time, edit the following option file:
Directory: QIBM/UserData/0S400/MGTC/Pervasive/
File: QYPV_OPTIONS.OPT

Add the following new entry to the option file (where nnnn, any whole number between 1-9999, is the
number of hours):

HOURS_OLD= nnnn

This is not case-sensitive and can be either on a separate line or separated by a space from the
READONLY entry.

For example, your newly edited file might read:

READONLY=no

HOURS_OLD=48
This gives you full access and shows tasks that have run in the last 48 hours.
Showing shared monitors

In the user options file, the SHARE_MON property specifies whether shared monitors display on the
wireless device.

* SHARE_MON-=yes
If you specify yes for this value, shared monitors appear on the display.
e SHARE_MON-=no

If you specify no for this value, shared monitors do not appear on the display. This is the default
value.

Configuring Application Administration

You can use Application Administration to control user access to limit or grant access to monitors and
commands in Management Central. Make sure that the functions selected in Application Administration
are configured to match your preferences for connecting to Management Central with a wireless device.

Examples:

* If users are not authorized to Management Central but have valid user IDs on the system, when they
try to connect to Management Central with a wireless device, an authorization error message is
displayed.

e If users are authorized to Management Central but do not have Application Administration authority
to access monitors, no monitor information is displayed on the wireless device.

* If users are not authorized to commands in Management Central, they cannot run a command
definition nor run a command on an Integrated xSeries Server.

Related concepts

[‘Connecting to your central system” on page 15|
To begin using iSeries Navigator for Wireless, you must first establish your connection to the central
system. Enter the URL of your central system into your wireless device.

[“Running commands across multiple systems” on page 22|
You can use iSeries Navigator for Wireless to run any i5/0S command across multiple systems. Select
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Run Command from the summary page, which then asks you to select the system or system group on
which to run the command. Or, select a system from your system list and run a command on it.

Related information

[Managing Application Administration|

Managing your systems with iSeries Navigator for Wireless

You can manage your systems from a wireless device. Use iSeries Navigator for Wireless to interact with
monitors in Management Central and in Integrated xSeries Servers. You can run commands, work with
tasks and systems, and control user access.

Using iSeries Navigator for Wireless is quite simple. After
your central system is set up, you can connect to it by
pointing your Internet-ready telephone, personal digital
assistant (PDA), or traditional Web browser to its URL.
The device connects to your central system, asks you to
log on, and shows you a summary of the status of all
Baries Movigater your systems, monitors, and tasks.
08/1LESOL  0B:00 AM
iSeries Navigator for Wireless is designed with the
assumption that as long as you can find out that your
(1].4 systems, monitors, and tasks are rurming smoothly, no
1p Syscems (3} othe.r informa’fion is reguired. You always have the option
z Reminors {4} to view more information, and you can even check the
5 Tazks (2} detailed monitor metrics on systems that are running
smoothly. But generally, if everything is OK, it is assumed
that the summary is all you need to look at.

When you manage your systems with iSeries Navigator
for Wireless, you can feel confident when your wireless
device tells you that everything in your network of
systems is OK, because you define what OK means in
your environment. If you set up the systems and
monitors you are interested in, and you tell the monitor
to be triggered at a certain threshold, then all you have to
do is to view the iSeries Navigator for Wireless summary
page and you can easily determine whether everything is
running smoothly or whether something needs attention.

Related concepts

[“Connecting to your central system” on page 15|
To begin using iSeries Navigator for Wireless, you must first establish your connection to the central
system. Enter the URL of your central system into your wireless device.

[“Setting up iSeries Navigator for Wireless” on page 3|

To use iSeries Navigator for Wireless, you must meet certain software and hardware requirements.
You must decide which kind of wireless device to use and what kind of applications you need to
install and configure.
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Working with systems

You can use iSeries Navigator for Wireless to view system properties and customize which systems are
displayed.

To view your systems, select the Systems link. Any systems that are not available are listed in a bold font
and marked by an explanation point. By default, the Systems link displays all of the systems to which
you are authorized.

Each system is also a link. Select a system to view the system properties and all the active Integrated
xSeries Servers on that system. If no Integrated xSeries Servers are active on that system, only the system
properties link appears. To see the properties of an active Integrated xSeries Server, click Integrated
Servers and your server.

You can customize your system list. You can add and remove systems from your system list, create a
default system list, or create system lists for specific users.

Adding and removing systems from your list
1. Go to the menu, and select Add System or Remove System.

2. Select the system to add or remove.

Because adding systems to your list can be cumbersome, administrators can create a default system list
that becomes the default list for any user. The user can then customize that list to their own liking. This
feature can be useful if a group of users is interested in data stored on the same five to ten systems.

Creating a default system list
In the following directory, create the following file:

Directory: QIBM/UserData/0S400/MGTC/Pervasive/
File: QYPV_SYSTEMS.txt

After you have created this file, add all the systems that you want to include in your default list on one
line, separated by a comma. You can also create a system list for a specific user by creating the file QYPV
xxxxx.txt, where xxxxx is the user profile name.

Related concepts

[“Working with Integrated xSeries Servers”|
With iSeries Navigator for Wireless, you can manage your Integrated xSeries Servers from your
wireless device.

Working with Integrated xSeries Servers

With iSeries Navigator for Wireless, you can manage your Integrated xSeries Servers from your wireless
device.

If your System i platform has Integrated xSeries Servers, you can manage the servers with iSeries
Navigator by adding the platform to your system list.

Note: To manage Integrated xSeries Servers from the System i platform, the user ID and password must
be the same on both the Integrated xSeries Servers and the System i platform.

When you select a system, you can either link to the system properties, or view the Integrated xSeries
Servers. The link to the Integrated xSeries Servers uses the same status as other iSeries Navigator for
Wireless functions. It tells you whether any Integrated xSeries Server needs attention, or whether all of
them are OK.
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You can run Windows commands on a single or on all Integrated xSeries Servers, and see server
properties.

1. To run Windows commands on the servers, select Run IS command from the menu and click Go.

2. To see the properties of a server, select the server on the Integrated Server page.

The Windows commands are started as Management Central tasks, so you can keep track of the
commands you run. shows Integrated xSeries Server support in iSeries Navigator for Wireless
running in a traditional browser format.

System1 System1 System1
SHSO 1 25815 P 1 Integrated Netfinity Servers InsServerS
SHFOT 15315 P SRS 125615 PM
1 Integrated Metfirby Servers (3)
1 Stm‘l?cd. 4 Ehut down 1 IntServer] : Shut dowm Network name: InsServers
Eropertics 1 IngSerw Shuat dewen Status: Started
Im E 1 InsServer : Shut down Descption:
rma 1 InsServerd Shut dowem Doimain: Workgroup
InsServers : Started DINS dornam name:
Connested users: ]

Processor whl: 0%
FPaging file uiil: 0%
Registy quota nhl:  28%
Harme vI EJ

Run Command...
Shut Dawn

Help

Figure 2. Clicking your Integrated xSeries Servers expands and displays the details of each system.

Related concepts

["Working with systems” on page 20|
You can use iSeries Navigator for Wireless to view system properties and customize which systems
are displayed.

[Windows environment on iSeries|

Working with tasks

With iSeries Navigator for Wireless, you can view summary details for all your Management Central
tasks.

Click Tasks from the main summary window to view summary details for the following Management
Central tasks:

¢ Commands

* Packages and Products
* Inventory

* Fixes

* Collection Services

e Users and Groups

* System Values

For each type of task, the task summary displays the total number of tasks, the number of tasks that have
failed, and the number of tasks that have completed. Only the tasks run in the last 24 hours display in
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your list. If you have not run a command in the last 24 hours, no information about commands is
displayed in the task summary window. Task information is set to expire in 24 hours, but you can change
this expiration by customizing your connection.

Click a specific task such as Commands to view the name or names of command tasks that are starting,
or that have completed or failed. Click the name of a specific task to view the endpoint system that the
task was or is running on.

Related concepts

[‘Customizing your connection” on page 17|

You can use several methods to customize connections to iSeries Navigator for Wireless. You can
control whether users can run commands and use monitors, and can specify how long tasks display
information.

Running commands across multiple systems

You can use iSeries Navigator for Wireless to run any i5/0S command across multiple systems. Select
Run Command from the summary page, which then asks you to select the system or system group on
which to run the command. Or, select a system from your system list and run a command on it.

When you select Run Command, you have the option of selecting an existing command definition
(defined by you in Management Central), or you can enter any command. Because entering text on a
telephone is cumbersome, using command definitions is extremely useful.

When commands are started, they are started as Management Central tasks. That way you can keep a
record of them, view the status across all systems, and view the overall status by looking at the summary
page. The summary page displays all the tasks you have run with Management Central (including iSeries
Navigator for Wireless) over the last 24 hours on your wireless device. After 24 hours, you need to use
iSeries Navigator on your PC to view a Command task. If you want to display task details on your
wireless device for longer than 24 hours, you can customize your connection.

[Figure 3 on page 23|shows a sample of iSeries Navigator for Wireless command support in a personal
digital assistant (PDA) format. If the command completes successfully, a plus sign (+) is displayed. On an
Internet telephone that supports graphics, a successful command is represented by a smiley face icon.
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WorkPad WorkPad

Figure 3. Viewing the status of your commands

Related concepts

[‘Customizing your connection” on page 17]

You can use several methods to customize connections to iSeries Navigator for Wireless. You can
control whether users can run commands and use monitors, and can specify how long tasks display
information.

Related reference

[Creating command definitions|

Viewing and interacting with monitors

If you have preconfigured monitors to run in Management Central, you can view and interact with
system monitors, message monitors, job monitors, file monitors, and B2B activity monitors using iSeries
Navigator for Wireless.

In the following figure, each Internet-ready telephone is displaying detailed metric information for a
system.
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Figure 4. Viewing monitor metrics on a wireless device

System monitors

You can work with system monitors to view the metrics and current values being monitored, as well as
the top 20 items (jobs, disk units, and so forth) that make up the metric value. You can also work with
jobs listed in the monitor (display details, hold, release, and end).

Select the System monitors link to display a list of all your active system monitors (any monitors that are
stopped are not shown). If any monitors failed or are triggered, an exclamation point or bell appears next
to the monitor.

When you select a monitor, it shows all systems where that monitor is running, and if you select a
system, it shows you all metrics in that monitor and the values for the selected system.

When you see and select the metric you are interested in, it shows you the top 20 items for that metric
value. For example, if you select CPU average, it shows you the top 20 jobs that use the most CPU. Or, if
you select Disk utilization, it shows you the top 20 disk units that have the highest disk utilization.

Note: In Management Central, multiple users can share system monitors. When using iSeries Navigator
for Wireless, you can view all shared monitors, not just the system monitors that you have created.
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Figure 5. Viewing system monitor metrics on a wireless device

From the list of jobs, you can also select a job to see details, and you can work with that job by selecting

Hold, Release, or End.

You can refresh each page to refresh the list at any time. You can also select Home to display an updated

summary page.

Because display size is minimal, the system monitor metric names are shortened. The following table
describes what iSeries Navigator for Wireless displays for each system monitor metric name.

Monitor metric names in iSeries Navigator for Wireless

System monitor metric names iSeries Navigator for Wireless name |Unit of measure
CPU Utilization (Average) CPU avg % busy

CPU Utilization (Interactive Jobs) CPU int jobs % busy

CPU Utilization (Interactive Feature) |CPU int feature %

CPU Utilization Basic (Average) CPU basic % busy

CPU Utilization (Secondary CPU 2nd workload %

Workloads)

CPU Utilization (Database Capability) | CPU DB %
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System monitor metric names

iSeries Navigator for Wireless name

Unit of measure

Interactive Response Time (Average)

Int resp avg

Seconds

Interactive Response Time
(Maximum)

Int resp max

Seconds

Transaction Rate (Average)

Trans rate avg

Transactions per second

Transaction Rate (Interactive)

Trans rate int

Transactions per second

Batch Logical Database I/O Batch DB IO 10/second
Disk Arm Utilization (Average) Disk util avg % busy
Disk Arm Utilization (Maximum) Disk util max % busy
Disk Storage (Average) Disk stg avg % full
Disk Storage (Maximum) Disk stg max % full
Disk IOP Utilization (Average) Disk IOP avg % busy
Disk IOP Utilization (Maximum) Disk IOP max % busy
Communications IOP Utilization Comm IOP avg % busy
(Average)

Communications IOP Utilization Comm IOP max % busy
(Maximum)

Communications Line Utilization Comm line avg % busy
(Average)

Communications Line Utilization Comm line max % busy
(Maximum

LAN Utilization (Average) LAN avg % busy
LAN Utilization (Maximum) LAN max % busy

Machine Pool Faults

Mch pool fault

Faults per second

User Pool Faults (Average)

Usr pool fault avg

Faults per second

User Pool Faults (Maximum)

Usr pool fault max

Faults per second

Related concepts

“Job monitors”

You can work with job monitors to view all jobs across systems that match monitor criteria. You can
see metrics and current values being monitored, and you can work with the jobs listed in the monitor
(display details, hold, release, and end).

[“Message monitors” on page 27|

You can work with message monitors to view all messages across systems that match monitor criteria.
And you can work with the messages listed in the monitor (display details, reply, and delete).

Job monitors

You can work with job monitors to view all jobs across systems that match monitor criteria. You can see
metrics and current values being monitored, and you can work with the jobs listed in the monitor
(display details, hold, release, and end).

Job monitors work the same way as the system monitors do in iSeries Navigator for Wireless. After you
create a job monitor in Management Central, you can start, stop, and view it in iSeries Navigator for
Wireless. You can also view the overall status of the job monitor, view the list of systems it is running on,
view the jobs that match the monitor criteria for each system, and work with a job using Hold, Release,

or End.

Note: In Management Central, multiple users can share job monitors. When using iSeries Navigator for
Wireless, you can view all shared monitors, not just the job monitors that you have created.
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Related concepts

['System monitors” on page 24|

You can work with system monitors to view the metrics and current values being monitored, as well
as the top 20 items (jobs, disk units, and so forth) that make up the metric value. You can also work
with jobs listed in the monitor (display details, hold, release, and end).

Message monitors
You can work with message monitors to view all messages across systems that match monitor criteria.
And you can work with the messages listed in the monitor (display details, reply, and delete).

Message monitors work the same way as system monitors do in iSeries Navigator for Wireless. After you
create a message monitor in Management Central, it shows up in iSeries Navigator for Wireless, and you
can view the overall status of the message monitor, view the list of systems it is running on, view the
messages that match the monitor criteria for each system, and work with a message using Details, Reply,
or Delete.

Note: In Management Central, multiple users can share message monitors. When using iSeries Navigator
for Wireless, you can view all shared monitors, not just the message monitors that you have
created.

Related concepts

[“System monitors” on page 24|

You can work with system monitors to view the metrics and current values being monitored, as well
as the top 20 items (jobs, disk units, and so forth) that make up the metric value. You can also work
with jobs listed in the monitor (display details, hold, release, and end).

File monitors

You can use a file monitor to notify you whenever a selected file has changed. Or, you can monitor for a
specified size or for specified text strings.

After you have created a file monitor in Management Central, you can start, stop, and display details
about the file monitor in iSeries Navigator for Wireless. The file monitor summary window displays the
system on which the monitor is running, the path to the current file you are viewing, the size of the file,
the last date and time the file was modified, and the changed text that triggered the file.

Note: In Management Central, multiple users can share file monitors. When using iSeries Navigator for
Wireless, you can view all shared monitors, not just the file monitors that you have created.

B2B activity monitors

If you have an application like Connect for System i configured, you can use a business-to-business (B2B)
activity monitor to monitor your B2B transactions. From a wireless device, you can view metrics and
current B2B transaction values being monitored.

To use a business-to-business activity monitor, you must configure a consolidated system to log B2B
transactions collected from an application like Connect for System i.

After you set up a B2B activity monitor in Management Central, you can start, stop, and view details
about the activity monitor in iSeries Navigator for Wireless. View summary status on active transaction
duration and active transaction count triggers collected from the B2B activity monitor.

Note: The B2B activity monitor data you want to view with iSeries Navigator for Wireless must be on a

system with OS/400 V5R2, or a later release. Any B2B activity monitor data stored on an earlier
system does not work with iSeries Navigator for Wireless.
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Related information for iSeries Navigator for Wireless

Listed below are the System i manuals and IBM Redbooks " (in PDF format), Web sites, and information
center topics that relate to the iSeries Navigator for Wireless topic. You can view or print any of the PDFs.

Manuals

[AS/400 Internet Security Scenarios: A Practical Approach| Q‘

Learn how to use the integrated network security functions. Today, network administrators face the
challenge of implementing layered security architectures to protect their networks from the increasing
sophistication of hackers. To provide all of the security needed within a manageable budget is a
complex task. This redbook explores all the network security features available on the system, such as
IP filters, Network Address Translation (NAT), virtual private network (VPN), HTTP proxy server,
Secure Sockets Layer (SSL), Domain Name System (DNS), mail relay, auditing, and logging. It describes
their use through practical examples.

Although the system is not intended to be a firewall, the correct implementation of its rich set of
network security services, combined with routers or other Internet security appliances, might eliminate
the need for a separate firewall product. In some cases, it can provide an affordable solution for
smaller sites. The network security functions can be used to enhance the security of environments
where routers with firewall security features are also used. This redbook is designed to meet the needs
of network administrators, consultants, and specialists who plan to design, implement, and configure
networks connected to the Internet and are evaluating alternatives to traditional firewall products.

Web sites

For more information about iSeries Navigator for Wireless, see [iSeries Navigator for Wireless| -l& .

The iSeries Navigator for Wireless home page gives you more information about this solution for
pervasive computing. This page contains information for supported releases.

For more information about iSeries Navigator, see liSeries Navigator] -Id' .

In addition to the Management Central functions, iSeries Navigator provides a wide variety of tools to
simplify System i management. The iSeries Navigator home page includes functional release
overviews, news about technical conferences, and other topics.

For more information about Web application servers, see the following Web sites:

— |ASF Jakarta Tomcat] 'Iﬁ’

The Apache Software Foundation Jakarta project home page provides detailed information about the
Tomcat servlet engine.

— [WebSphere Application Server| -lﬁ'

The latest information about the WebSphere Application Server for i5/0S is located in the
WebSphere Application Server for i5/0S product Web site.

Saving PDF files

To save a PDF on your workstation for viewing or printing:

1.

Right-click the PDF in your browser (right-click the link above).

2. Click the option that saves the PDF locally.
3.
4. Click Save.

Navigate to the directory in which you want to save the PDFE.
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http://www.redbooks.ibm.com/abstracts/sg245954.html
http://www.ibm.com/servers/eserver/iseries/navigator/pervasive.html
http://www.ibm.com/servers/eserver/iseries/navigator/index.html
http://jakarta.apache.org/
http://www.ibm.com/servers/eserver/iseries/software/websphere/wsappserver/

Downloading Adobe Reader

| You need Adobe Reader installed on your system to view or print these PDFs. You can download a free

| copy from the [Adobe Web site| (www.adobe.com/products/acrobat/ readstep.html)'-ld' .

iSeries Navigator for Wireless 29


http://www.adobe.com/products/acrobat/readstep.html

30 System i: Connecting to System i iSeries Navigator for Wireless



Appendix. Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that
only that IBM product, program, or service may be used. Any functionally equivalent product, program,
or service that does not infringe any IBM intellectual property right may be used instead. However, it is
the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or
service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You can send
license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION
PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some
states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this
statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of
the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation

© Copyright IBM Corp. 2002, 2006 31



Software Interoperability Coordinator, Department YBWA
3605 Highway 52 N

Rochester, MN 55901

US.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.

The licensed program described in this information and all licensed material available for it are provided
by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement,
IBM License Agreement for Machine Code, or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some measurements may have
been made on development-level systems and there is no guarantee that these measurements will be the
same on generally available systems. Furthermore, some measurements may have been estimated through
extrapolation. Actual results may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of
those products.

All statements regarding IBM’s future direction or intent are subject to change or withdrawal without
notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to the names and addresses used by an
actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming
techniques on various operating platforms. You may copy, modify, and distribute these sample programs
in any form without payment to IBM, for the purposes of developing, using, marketing or distributing
application programs conforming to the application programming interface for the operating platform for
which the sample programs are written. These examples have not been thoroughly tested under all
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these
programs.

Each copy or any portion of these sample programs or any derivative work, must include a copyright
notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp. Sample Programs. ©
Copyright IBM Corp. _enter the year or years_. All rights reserved.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.

Programming Interface Information

This iSeries Navigator for Wireless publication documents intended Programming Interfaces that allow
the customer to write programs to obtain the services of IBM i5/0S.
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Trademarks

The following terms are trademarks of International Business Machines Corporation in the United States,
other countries, or both:

AS/400
i5/0S

IBM

IBM (logo)
iSeries
Redbooks
0S/400
System i
WebSphere

xSeries

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the
United States, other countries, or both.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United States, other
countries, or both.

Other company, product, or service names may be trademarks or service marks of others.

Terms and conditions

Permissions for the use of these publications is granted subject to the following terms and conditions.

Personal Use: You may reproduce these publications for your personal, noncommercial use provided that
all proprietary notices are preserved. You may not distribute, display or make derivative works of these
publications, or any portion thereof, without the express consent of IBM.

Commercial Use: You may reproduce, distribute and display these publications solely within your
enterprise provided that all proprietary notices are preserved. You may not make derivative works of
these publications, or reproduce, distribute or display these publications or any portion thereof outside
your enterprise, without the express consent of IBM.

Except as expressly granted in this permission, no other permissions, licenses or rights are granted, either
express or implied, to the publications or any information, data, software or other intellectual property
contained therein.

IBM reserves the right to withdraw the permissions granted herein whenever, in its discretion, the use of
the publications is detrimental to its interest or, as determined by IBM, the above instructions are not
being properly followed.

You may not download, export or re-export this information except in full compliance with all applicable
laws and regulations, including all United States export laws and regulations.

IBM MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE PUBLICATIONS. THE
PUBLICATIONS ARE PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF
MERCHANTABILITY, NON-INFRINGEMENT, AND FITNESS FOR A PARTICULAR PURPOSE.
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